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1 Περιεχόμενα Συσκευασίας 
 
 
 
 
 
 
 
 

 
1. BT 100 USB Bluetooth Dongle  
2. CD με το λογισμικό BlueSoleil 
3. Εκτυπωμένο εγχειρίδιο χρήστη 
4. Εγγύηση 

2 Το BT 100 USB Bluetooth Dongle 
 
Συγχαρητήρια για την αγορά του BT 100 USB Bluetooth Dongle. Πρόκειται για μία 
συσκευή που σας δίνει τη δυνατότητα να συνδέσετε ασύρματα (μέσω Bluetooth) με τον 
υπολογιστή σας συσκευές που υποστηρίζουν την τεχνολογία Bluetooth, όπως κινητά 
τηλέφωνα, PDA, πληκτρολόγιο, ποντίκι, εκτυπωτή και άλλα. 
 
Απλά συνδέστε το BT 100 σε μία ελεύθερη USB θύρα του υπολογιστή σας, 
εγκαταστήστε το λογισμικό BlueSoleil και είστε έτοιμοι να εκμεταλλευτείτε στο έπακρο 
τις δυνατότητες της τεχνολογίας Bluetooth. Μπορείτε να συνδεθείτε στο Internet, να 
κρατήσετε αντίγραφα ασφαλείας του τηλεφωνικού σας καταλόγου και των επαφών σας, 
να μοιραστείτε φωτογραφίες και άλλα αρχεία. 

2.1 Χαρακτηριστικά Προϊόντος 

• Συμβατό με Windows Vista  
• Συμβατό με το πρόγραμμα Skype  
• Συμβατό με το πρότυπο Bluetooth V2.0/1.2/1.1  
• Ρυθμός μεταφοράς δεδομένων μέχρι 3 Mbps 
• Εμβέλεια μέχρι 100m (Class 1) 
• Χαμηλή κατανάλωση ρεύματος 
• Ενσωματωμένη κεραία 
• Υποστηρίζει 2.4GHz FHSS (Frequency Hopping Spread Spectrum) 
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• Εύκολη εγκατάσταση 

3 Απαιτήσεις Συστήματος 
 

• 1 ελεύθερη θύρα USB 
• Windows 2000/XP/Vista 
• CD-ROM Drive 

Σημείωση: Η παρούσα έκδοση δεν λειτουργεί σωστά σε περιβάλλον XP 
(service pack 1)   
 

4 Εγκατάσταση Υλικού 
 
Για να συνδέσετε το BT 100 USB Bluetooth Dongle στον υπολογιστή σας, απλά 
συνδέστε το σε μία ελεύθερη θύρα USB. 
 
Αν το BT 100 δεν μπορεί να εγκατασταθεί αυτόματα στον υπολογιστή σας όταν το 
συνδέσετε, Ακολουθήστε την παρακάτω διαδικασία. Εμφανίζεται ο οδηγός 
εγκατάστασης νέου υλικού (Found New Hardware Wizard): 

 
Επιλέξτε αν θέλετε να συνδεθούν τα Windows με το Windows Update για να βρουν το 
κατάλληλο λογισμικό ή όχι και πατήστε Next. 
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Πατήστε Next. 
 

 
Πατήστε Finish. 
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5 Εγκατάσταση Λογισμικού 
 
Το λογισμικό που περιλαμβάνεται είναι το BlueSoleil. Πρόκειται για ένα πρόγραμμα της 
IVT που επιτρέπει σε έναν υπολογιστή με Bluetooth να συνδεθεί με άλλες συσκευές που 
υποστηρίζουν την τεχνολογία Bluetooth, όπως κάμερες, κινητά τηλέφωνα, headsets, 
εκτυπωτές και άλλα. Επίσης μπορείτε να σχηματίσετε δίκτυα και να ανταλλάσσετε 
δεδομένα με άλλες Bluetooth συσκευές. 
 
Προσοχή: Αν έχετε ήδη εγκατεστημένο κάποιο λογισμικό για Bluetooth στον 
υπολογιστή σας, θα πρέπει να το απεγκαταστήσετε πριν την εγκατάσταση BlueSoleil! 
 
Για να εγκαταστήσετε το λογισμικό, ακολουθήστε τα παρακάτω βήματα: 
Εισάγετε το CD εγκατάστασης στον οδηγό. Αν ο οδηγός εγκατάστασης δεν ανοίξει 
αυτόματα, πηγαίνετε στο  Start → My Computer, κάντε δεξί κλικ στο εικονίδιο του CD 
ROM και επιλέξτε Open από το μενού που εμφανίζεται. Ανοίξτε τον φάκελο IVT 2.7.0.8,  
Κάντε διπλό κλικ στο αρχείο Setup.exe.  

 

 
Το παραπάνω παράθυρο εμφανίζεται μόνο σε περιβάλλον Windows Vista. Πατήστε Run 
Setup.exe. 
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Επιλέξτε τη γλώσσα της εγκατάστασης και πατήστε OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πατήστε Next. 
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Επιλέξτε  “I accept the terms in the license agreement” και πατήστε Yes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πραγματοποιήστε την επιλογή σας και πατήστε Next για να συνεχίσετε. 
Σημείωση: Το παραπάνω παράθυρο δεν εμφανίζεται σε περιβάλλον Windows Vista 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πατήστε Change αν επιθυμείτε το  Bluesoleil να εγκατασταθεί σε διαφορετικό φάκελο. 
Πατήστε Next για να συνεχίσετε με την διαδικασία εγκατάστασης. 
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Πατήστε Install 
Πατήστε Finish για να ολοκληρωθεί η διαδικασία εγκατάστασης. 
 
Όταν ο υπολογιστής σας επανεκκινήσει, το BlueSoleil θα ανοίξει και εμφανίζεται η 
οθόνη Welcome to Bluetooth: 
 

Device Name: Εισάγετε ένα 
όνομα για τη συσκευή σας, 
το οποίο θα εμφανίζεται στις 
συσκευές που συνδέονται με 
τη δική σας. 
 
Device Type: Επιλέξτε τον 
τύπο της συσκευής σας 
(Desktop, Laptop or Server). 
 
Μπορείτε να επιλέξτε 
medeium security level  αν 
το επιθυμείτε. 
 
Πατήστε OK. 
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6 Το Λογισμικό BlueSoleil  
 
Στο κεφάλαιο αυτό περιγράφονται οι βασικές λειτουργίες του BlueSoleil. Για 
περισσότερες πληροφορίες ανατρέξτε στη βοήθεια του προγράμματος. 

6.1 Υποστηριζόμενα Προφίλ 

Το BlueSoleil υποστηρίζει τα ακόλουθα Bluetooth Profiles στους εξής ρόλους: 
Device Role Bluetooth Profiles Client Server 

AV Headphone * √ √ 

Basic Image Profile (BIP) √ √ 

Dial-Up Networking √  

Fax √  

File Transfer √ √ 

Headset * √ √ 

Human Interface Device √  

Object Push √ √ 

Personal Area Networking √ √ 

Printer √  

Serial Port √ √ 

Synchronization √ √ 
 
Σημειώσεις: 

1. Μόνο ένα Headset ή AV Headphone μπορεί να είναι συνδεδεμένο κάθε φορά 
στον υπολογιστή, γιατί υπάρχει μόνο μία εικονική συσκευή Bluetooth audio. 

2. Τα προφίλ Headset και AV Headphone δεν υποστηρίζονται από τα Windows 98SE 
και Windows ME. 
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6.2 Το περιβάλλον του BlueSoleil  

6.2.1 Main Window 
Αυτό είναι το κυρίως παράθυρο του BlueSoleil: 

 
Σε αυτό το παράθυρο εμφανίζεται η τοπική συσκευή (η κόκκινη μπάλα) καθώς και οι 
απομακρυσμένες συσκευές που βρίσκονται μέσα στην εμβέλεια του Bluetooth. Κάθε 
τύπος συσκευής παριστάνεται με ένα διαφορετικό εικονίδιο. Στο πάνω μέρος του 
παραθύρου υπάρχουν τα Service Buttons, που αντιστοιχούν στις υποστηριζόμενες 
υπηρεσίες. Αν επιλέξετε μία συσκευή,  τα Service Buttons που αντιστοιχούν στις 
υπηρεσίες που υποστηρίζει θα εμφανιστούν επιλεγμένα. 
 
Απομακρυσμένες συσκευές – Επεξήγηση εικονιδίων: 

• Άσπρο: Αδρανής. Η κανονική κατάσταση της συσκευής. 
• Κίτρινο: Επιλεγμένη. Έχετε επιλέξει τη συσκευή. 
• Πράσινο: Συνδεδεμένη. Η συσκευή είναι συνδεδεμένη με την τοπική συσκευή. 
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Υπηρεσίες – Επεξήγηση εικονιδίων: 
• Άσπρο: Αδρανής. Η κανονική κατάσταση. 
• Κίτρινο: Διαθέσιμη. Η υπηρεσία είναι διαθέσιμη για την επιλεγμένη συσκευή. 
• Πράσινο: Συνδεδεμένη. Η υπηρεσία είναι ενεργή σε μια σύνδεση με την 

απομακρυσμένη συσκευή.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Σημείωση: Δεδομένου ότι η έκδοση του Bluesoleil v 2.7.0.8 είναι συμβατή με  το 

πρόγραμμα Skype, όταν εμφανίζεται το παραπάνω παράθυρο, είναι στην διακριτική σας 
ευχέρεια το να επιλέξετε την λειτουργία αυτή. 

6.2.2 Service Window 
Πατήστε View → Service Window για να δείτε το Service Window: 
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Σε αυτό το παράθυρο εμφανίζονται οι υπηρεσίες που υποστηρίζονται από την τοπική 
συσκευή. 
Επεξήγηση εικονιδίων: 

• Άσπρο: Αδρανής. Η υπηρεσία δεν έχει ξεκινήσει. 
• Κίτρινο: Η τοπική υπηρεσία Bluetooth έχει ξεκινήσει. 
• Πράσινο: Συνδεδεμένη. Μία απομακρυσμένη συσκευή έχει συνδεθεί στην 

υπηρεσία.  
 
Σημείωση: Στο παράθυρο αυτό δεν εμφανίζονται τα εικονίδια για τις εξής υπηρεσίες: 
Printer και Fax. Τα εικονίδια αυτά εμφανίζονται όταν ένας Bluetooth εκτυπωτής ή ένα 
Bluetooth Fax συνδεθούν στον υπολογιστή. 
 

6.3 Βασικές Λειτουργίες 

6.3.1 Εκκίνηση του Bluetooth 
Για να ανοίξετε το BlueSoleil κάντε διπλό κλικ στο αντίστοιχο εικονίδιο στην επιφάνεια 

εργασίας.  

Εναλλακτικά, μπορείτε να πατήσετε Start → All Programs → IVT BlueSoleil → 
BlueSoleil. 
 
Το BlueSoleil ανιχνεύει τη σύνδεση και την αποσύνδεση του USB dongle. Επίσης 
μπορείτε να ξεκινήσετε πρώτα το BlueSoleil και μετά να συνδέσετε το USB dongle. 
 

6.3.2 Αναζήτηση άλλων συσκευών Bluetooth 
Για να βρείτε άλλες Bluetooth συσκευές που βρίσκονται εντός της εμβέλειας, πηγαίντε 
στο Main Window και πατήστε πάνω στην κόκκινη μπάλα. Μετά από μερικά 
δευτερόλεπτα ένα εικονίδιο θα εμφανιστεί γύρω από την κόκκινη μπάλα για κάθε 
συσκευή Bluetooth που βρίσκεται εντός της εμβέλειας. 
Επίσης μπορείτε να πάτε στο View → Refresh Devices ή να πατήσετε F5 για να 
ανανεωθεί η λίστα συσκευών. 
  
Σημειώσεις: 
• Στο Main Window μπορούν να εμφανίζονται ταυτόχρονα 8 το πολύ συσκευές. Αν 

βρεθούν περισσότερες από 8 συσκευές, χρησιμοποιείστε τη μπάρα κύλισης (scroll 
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bar) για να δείτε τις υπόλοιπες συσκευές. 
• Αν πατήσετε Refresh Devices ή ξεκινήσετε αναζήτηση συσκευών πατώντας πάνω 

στην κόκκινη μπάλα, η λίστα με τις συσκευές που είχαν ανιχνευθεί μέχρι τώρα δε θα 
αδειάσει. Αντίθετα, αν πατήσετε F5 η λίστα αυτή θα αδειάσει. 
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6.3.3 Εγκαθίδρυση Bluetooth Σύνδεσης 
Σε κάθε περίπτωση η συσκευή που έχει το ρόλο client πρέπει να ξεκινά τη σύνδεση. 
Ανατρέξτε στο διάγραμμα του κεφαλαίου 6.1 για να δείτε ποιο ρόλο υποστηρίζει το 
BlueSoleil για την υπηρεσία που θέλετε να χρησιμοποιήσετε. 
 

• Στον server, εκκινήστε την υπηρεσία. 
1. Ανοίξτε το Service Window (πατήστε View → Service Window ) 
2. Αν το εικονίδιο μιας υπηρεσίας εμφανίζεται με κίτρινο χρώμα, η υπηρεσία έχει 

ήδη ξεκινήσει. Αν το εικονίδιο εμφανίζεται με άσπρο χρώμα, κάντε δεξί κλικ στο 
εικονίδιο και επιλέξτε Start Service από το μενού που εμφανίζεται, για να 
εκκινήσετε την υπηρεσία. 

3. Τώρα πρέπει να ξεκινήσετε τη σύνδεση από την απομακρυσμένη συσκευή. Για το 
σκοπό αυτό, ανατρέξτε στο εγχειρίδιο χρήσης της αντίστοιχης συσκευής. 

  
• Στον client, εκκινήστε τη σύνδεση. 

 
1. Βεβαιωθείτε ότι βρίσκεστε στο Main Window. 
2. Αν θέλετε να εντοπίσετε απομακρυσμένες συσκευές, κάντε κλικ πάνω στην 

κόκκινη μπάλα. 
3. Κάντε διπλό κλικ στο εικονίδιο της συσκευής στην οποία θέλετε να συνδεθείτε.  
4. Στο πάνω μέρος του Main Window, τα εικονίδια των υπηρεσιών που 

υποστηρίζονται από την απομακρυσμένη συσκευή εμφανίζονται με κίτρινο 
χρώμα. 

5. Κάντε κλικ στο εικονίδιο της υπηρεσίας την οποία θέλετε να χρησιμοποιήσετε. 
Ανάλογα με τις ρυθμίσεις ασφαλείας της κάθε συσκευής, ενδέχεται να χρειαστεί 
να εισάγετε το ίδιο passkey στις δύο συσκευές (για να γίνουν pair).  

 
Όταν εγκαθιδρυθεί η σύνδεση, το εικονίδιο της απομακρυσμένης συσκευής στο Main 
Window εμφανίζεται με πράσινο χρώμα και μία πράσινη γραμμή εμφανίζεται να 
συνδέει την απομακρυσμένη συσκευή με την κόκκινη μπάλα. Μία κόκκινη κουκκίδα 
μετακινείται κατά μήκος της γραμμής αυτής από τον client προς τον server. Δίπλα 
στο εικονίδιο της συσκευής εμφανίζεται ένα εικονίδιο που αντιστοιχεί στην ισχύ του 
σήματος.  
Αν έχετε κάνει pair τις συσκευές, ένα κόκκινο √ εμφανίζεται δίπλα στο όνομα της 
συσκευής. 
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6.3.4 Τερματισμός Bluetooth Σύνδεσης 
• Τερματισμός Σύνδεσης στον Server 
Για να τερματίσετε τη σύνδεση στον server, σταματήστε την αντίστοιχη υπηρεσία. Αν 
η σύνδεση διακοπεί ενώ μεταφέρονται δεδομένα, υπάρχει κίνδυνος κάποια δεδομένα 
να χαθούν. Συνίσταται να τερματίζεται η σύνδεση στον πελάτη (client). 
Για να σταματήσετε μία υπηρεσία πηγαίνετε στο Service Window, κάντε δεξί κλικ σε 
μια υπηρεσία που έχει εκκινηθεί και επιλέξτε Stop Service από το μενού που 
εμφανίζεται.  
Όταν η υπηρεσία σταματήσει, το εικονίδιό της θα εμφανίζεται με άσπρο χρώμα. 
 
• Τερματισμός Σύνδεσης στον Client 
Στο Main Window, επιλέξτε την απομακρυσμένη συσκευή που επιθυμείτε. Μόλις το 
εικονίδιο υπηρεσιών εμφανιστούν με κίτρινο χρώμα, κάντε δεξί κλικ στο εικονίδιο 
της υπηρεσίας που θέλετε να σταματήσετε και επιλέξτε Disconnect από το μενού που 
εμφανίζεται. 
 

6.3.5 Ρυθμίσεις Ασφαλείας 

Γενικά 
Για να δείτε και να αλλάξετε τις ρυθμίσεις ασφαλείας, πατήστε My Bluetooth → 
Security. 
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Το BlueSoleil υποστηρίζει τρία επίπεδα ασφάλειας: 
 

• Low (Security Mode 1, No security) 
Καμία ασφάλεια. Άλλες συσκευές μπορούν να συνδεθούν στον υπολογιστή σας 
χωρίς passkey. 
 
• Medium (Security Mode 2, Service level enforced security) 
Απαιτείται Authentication (πιστοποίηση) ή Authorization (έγκριση) για να συνδεθεί 
μια απομακρυσμένη Bluetooth συσκευή. Αν δύο συσκευές συνδέονται για πρώτη 
φορά, ή αν δύο συσκευές δεν έχουν έμπιστη σχέση (trusted relationship), τότε το ίδιο 
passkey πρέπει να εισαχθεί και στις δύο συσκευές. Αυτό το επίπεδο ασφαλείας σας 
επιτρέπει να ορίσετε διαφορετικά δικαιώματα πρόσβασης για κάθε υπηρεσία που 
υποστηρίζεται από τη συσκευή – server. 
 
• High (Security Mode 3, Link level enforced security) 
Αν τουλάχιστον μία από τις δύο συσκευές είναι σε αυτό το επίπεδο ασφαλείας, 
απαιτείται πιστοποίηση για κάθε σύνδεση που εγκαθιδρύεται ανάμεσα στις δύο 
συσκευές. Για να ολοκληρωθεί η πιστοποίηση πρέπει να δοθεί το ίδιο passkey και 
στις δύο πλευρές. 
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Σημείωση: 
Στο μεσαίο επίπεδο ασφαλείας, ο χρήστης μπορεί να προσθέσει κάθε συσκευή που 
έχει περάσει την πιστοποίηση σε μια λίστα με έμπιστες συσκευές, ώστε να 
διευκολύνονται οι επόμενες συνδέσεις. 
 

Pair/ Un-pair Συσκευών 
• Πώς να κάνετε pair με μία άλλη συσκευή 
Αν απαιτείται passkey για να γίνει μια σύνδεση, οι συσκευές θα εκκινήσουν τη 
διαδικασία του pairing αυτόματα. Αν θέλετε να την εκκινήσετε εσείς, πηγαίνετε στο 
Main Window, κάντε δεξί κλικ στο εικονίδιο της συσκευής που επιθυμείτε και 
πατήστε Pair Device. 
Και στις δύο περιπτώσεις εμφανίζεται το παράθυρο Enter Bluetooth Passkey και θα 
πρέπει να εισάγετε το  passkey στις συσκευές. 

 

• Πώς να κάνετε unpair 
Στο Main Window κάντε δεξί κλικ στο εικονίδιο της συσκευής και πατήστε Unpair 
στο μενού που εμφανίζεται. 

 
 

6.4 Προφίλ (Profiles) 

6.4.1 Advanced Audio 
Το Advanced Audio Profile σας επιτρέπει να ακούτε μουσική που παίζεται στον 
υπολογιστή σας, χρησιμοποιώντας ένα Bluetooth AV headphone: 
 
1. Συνδεθείτε στο AV headphone. 
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2. Παίξτε μουσική στον υπολογιστή σας χρησιμοποιώντας κατάλληλο λογισμικό. Η 
μουσική μεταδίδεται ασύρματα στα ακουστικά. 

 

6.4.2 Basic Imaging 
Το Basic Imaging Profile (BIP) σας επιτρέπει να λαμβάνεται εικόνες από μία Bluetooth 
συσκευή όπως ψηφιακή κάμερα ή κινητό τηλέφωνο. Επίσης σας δίνει τη δυνατότητα να 
ελέγξετε από τον υπολογιστή σας τη λήψη ή την προβολή φωτογραφιών. 
  
Λήψη Φωτογραφιών μέσω της Κάμερας 

1. Συνδεθείτε στην κάμερα. 
Εμφανίζεται το παράθυρο Bluetooth Camera Controller. 

 

2. Πατήστε Capture για τη λήψη εικόνας. Η εικόνα αυτή θα μεταδοθεί και θα 
εμφανιστεί στον υπολογιστή σας. 

 
Λήψη Εικόνων 

1. Ορίστε τον κατάλογο στον οποίο θέλετε να αποθηκεύσετε τις εικόνες που θα 
σταλούν από τη συσκευή – πελάτη. Πηγαίντε My Services → Properties και 
επιλέξτε την καρτέλα Basic Image Push. 
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2. Στο πεδίο Set the image download folder, επιλέξτε τον κατάλογο που επιθυμείτε 

και πατήστε OK.  
3. Εκκινήστε την υπηρεσία BIP. 
4. Στείλτε εικόνες από την απομακρυσμένη συσκευή. Για οδηγίες σχετικές με το 

θέμα αυτό, ανατρέξτε στο εγχειρίδιο χρήσης της απομακρυσμένης συσκευής. 
 
Σημείωση: Επειδή η ΒΙΡ είναι μια εξελιγμένη υπηρεσία, το Bluetooth κινητό τηλέφωνο 
που θέλετε να συνδέσετε πρέπει να υποστηρίζει το Audio / Video Remote Control Profile 
(AVRCP) και να είναι συμβατό με την έκδοση Bluetooth V1.2. 

 

6.4.3 Dial-up Networking 
Το Bluetooth Dial-up Networking (DUN) Profile σας επιτρέπει να κάνετε κλήση στο 
Internet ασύρματα, μέσω ενός Bluetooth modem ή ενός κινητού τηλεφώνου που 
υποστηρίζει το DUN Profile. 

 
Κλήση Dial-up στο Internet μέσω ενός κινητού τηλεφώνου Bluetooth ή Bluetooth 
μόντεμ 
1. Συνδεθείτε στην υπηρεσία Dial-up Networking της απομακρυσμένης συσκευής. 
2. Εμφανίζεται το ακόλουθο παράθυρο:  
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Εισάγετε το όνομα χρήστη (User name), τον κωδικό (Password), το νούμερο του 
τηλεφώνου και πατήστε Dial. 
 
Σημείωση: 
Το προκαθορισμένο νούμερο τηλεφώνου *99***1# λειτουργεί μόνο για ορισμένα 
τηλέφωνα GPRS και ορισμένους παροχείς υπηρεσιών. Εισάγετε το σωστό αριθμό που 
αντιστοιχεί στον δικό σας Παροχέα Υπηρεσιών Ίντερνετ (ISP). 
 
Όταν συνδεθείτε, θα εμφανιστεί ένα παράθυρο για να επιλέξετε αν θέλετε να 
δημιουργήσετε συντόμευση για την dial-up σύνδεση στην επιφάνεια εργασίας σας. Αυτό 
σας επιτρέπει να χρησιμοποιείτε τη dial-up σύνδεση πατώντας το εικονίδιο της 
συντόμευσης. 

 

6.4.4 FAX 
To Bluetooth FAX profile σας επιτρέπει να στείλετε fax από τον υπολογιστή σας μέσω 
ενός τηλεφώνου ή μόντεμ με Bluetooth. 
 
Αποστολή FAX μέσω ενός κινητού τηλεφώνου με Bluetooth 

1. Συνδεθείτε στην υπηρεσία FAX του τηλεφώνου. 
2. Χρησιμοποιήστε το λογισμικό που έχετε για fax για να στείλετε μηνύματα. 
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Αποστολή FAX μέσω ενός μόντεμ με Bluetooth 

1. Συνδεθείτε στην υπηρεσία FAX του μόντεμ. 
2. Ξεκινήστε την λογισμικό που έχετε για fax. Ρυθμίστε το λογισμικό σας για το 

Bluetooth Fax Modem (ΟΧΙ για το Bluetooth Modem). Ανατρέξτε στη βοήθεια 
του αντίστοιχου προγράμματος για περισσότερες πληροφορίες. 

Χρησιμοποιήστε το λογισμικό που έχετε για fax για να στείλετε μηνύματα 
 

6.4.5 File Transfer 
Το File Transfer Profile (FTP) σας επιτρέπει να κάνετε ανταλλαγή αρχείων και φακέλων 
μεταξύ συσκευών που υποστηρίζουν Bluetooth. 
 
Σύνδεση με τηλέφωνο 

1. Συνδεθείτε με την υπηρεσία FTP του τηλεφώνου. 
2. Εμφανίζεται ένα παράθυρο όπου φαίνονται οι φάκελοι του τηλεφώνου. Μπορείτε 

να μεταφέρετε και να διαγράψετε αρχεία και φακέλους. 
 
Μοιραστείτε ένα φάκελο του Υπολογιστή σας με άλλες συσκευές Bluetooth 

1. Επιλέξτε το φάκελο τον οποίο θέλετε να μοιραστείτε και καθορίστε τα προνόμια 
του απομακρυσμένου χρήστη. Για να το κάνετε αυτό, πηγαίνετε στο My Services 
→ Properties και επιλέξτε την καρτέλα File Transfer. 
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Share this folder: Βρείτε και επιλέξτε το φάκελο που θέλετε να μοιραστείτε. 
Share Permissions:  
• Επιλέξτε Read and Write για να επιτρέψετε σε άλλους να βλέπουν, να 

αντιγράφουν ή να διαγράφουν τα αρχεία και τους φακέλους που βρίσκονται στο 
φάκελο που έχετε μοιραστεί. 

• Επιλέξτε Read Only για να επιτρέψετε σε άλλους μόνο να βλέπουν και να 
αντιγράφουν αρχεία και φακέλους που βρίσκονται στο φάκελο που έχετε 
μοιραστεί. 

 
2. Εκκινήστε την υπηρεσία FTP στο BlueSoleil. Μην εκκινήσετε τη σύνδεση στο 

BlueSoleil. 
3. Βρείτε τον υπολογιστή σας από την απομακρυσμένη συσκευή και συνδεθεθείτε 

(ανατρέξτε στο εγχειρίδιο της απομακρυσμένης συσκευής για περισσότερες 
πληροφορίες). Όταν η απομακρυσμένη συσκευή προσπαθήσει να συνδεθεί με τον 
υπολογιστή σας, μπορεί να εμφανιστεί το παράθυρο Bluetooth Service 
Authorization. 
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Πατήστε Yes. 

 
Πρόσβαση σε Φάκελο που έχει μοιραστεί μια άλλη Bluetooth Συσκευή 

1. Στην απομακρυσμένη συσκευή καθορίστε το φάκελο που θέλετε να μοιραστείτε. 
Ενεργοποιήστε το file sharing στην απομακρυσμένη συσκευή. Για οδηγίες 
σχετικές με το θέμα αυτό, ανατρέξτε στο εγχειρίδιο της απομακρυσμένης 
συσκευής. 
Σημείωση: Αν δεν ενεργοποιήσετε το file sharing στην απομακρυσμένη συσκευή, 
το BlueSoleil δε θα μπορεί να βρει την αντίστοιχη υπηρεσία για τη συσκευή αυτή. 

2. Εκκινήστε την υπηρεσία FTP και εκκινήστε τη σύνδεση στο BlueSoleil. 
3. Θα εμφανιστεί ένα παράθυρο Remote Shared Folder, στο οποίο εμφανίζονται οι 

φάκελοι και τα αρχεία που έχει μοιραστεί η απομακρυσμένη συσκευή. Μέσα από 
το παράθυρο αυτό μπορείτε να δείτε, να αντιγράψετε ή και να διαγράψετε αρχεία, 
ανάλογα με τις ρυθμίσεις. 

 

6.4.6 Headset 
Το Headset Profile σας επιτρέπει να χρησιμοποιήσετε ένα Bluetooth headset (ακουστικό 
και μικρόφωνο κεφαλής) ως ασύρματο μικρόφωνο και ακουστικά. 
 
Χρησιμοποιήστε το Headset ως συσκευή για Είσοδο/Έξοδο ήχου 

1. Συνδεθείτε στο Bluetooth headset. 
2. Παίξτε μουσική στον υπολογιστή σας ή κάντε chat χρησιμοποιώντας το 

μικρόφωνο. 
 
Σημείωση: 
Για τα περισσότερα Bluetooth headsets, αφού συνδεθείτε για πρώτη φορά επιτυχώς, 
μπορείτε να συνδεθείτε ξανά στο BlueSoleil πατώντας απλά ένα κουμπί 
(multifunction button) πάνω στο headset. 
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6.4.7 Human Interface Device 
Το Bluetooth Human Interface Device (HID) Profile σας επιτρέπει να συνδέσετε ένα 
Bluetooth ποντίκι ή πληκτρολόγιο στον υπολογιστή σας. Μπορείτε να συνδέσετε όποια  
Bluetooth συσκευή υποστηρίζει το HID και να ασκήσετε απομακρυσμένο έλεγχο σε 
ορισμένες λειτουργίες του υπολογιστή σας. 
  
Mouse: Συνδέστε το Bluetooth ποντίκι στον υπολογιστή σας. 
 
Keyboard: Συνδέστε το Bluetooth πληκτρολόγιο στον υπολογιστή σας. (Πριν 
χρησιμοποιήσετε το BlueSoleil για να συνδεθείτε, ίσως χρειαστεί να κάνετε το 
πληκτρολόγιο discoverable) 
 
Σημείωση: 
Την πρώτη φορά που συνδέετε το ποντίκι ή το πληκτρολόγιο στον υπολογιστή σας θα 
ανοίξει αυτόματα ο οδηγός εγκατάστασης νέου υλικού (Found New Hardware Wizard). 
Στην αρχική οθόνη του οδηγού επιλέξτε do not insert any CD και πατήστε Next.  
 
Το Bluetooth ποντίκι ή πληκτρολόγιο μπορεί να επανασυνδεθεί αυτόματα στον 
υπολογιστή σας, μετά την πρώτη επιτυχή σύνδεση. 
 

 

6.4.8 Object Push 
Το Bluetooth Object Push Profile (OPP) σας επιτρέπει να στέλνετε σε ένα PDA ή κινητό 
με Bluetooth (και να λαμβάνετε) αντικείμενα Personal Information Management (PIM). 
Τα αντικείμενα αυτά μπορεί να είναι: 

1. Επαφές (Contacts) (*.vcf) 
2. Ημερολόγια (Calendars) (*.vcs) 
3. Σημειώσεις (Notes) (*.vnt) 
4. Μηνύματα (Messages) (*.vmg) 

 
Push Objects προς ένα Κινητό Τηλέφωνο με Bluetooth 
Υπάρχουν δύο τρόποι για να κάνετε push τα αντικείμενα: 

1. Από το Main Window του BlueSoleil: 
Κάντε διπλό κλικ στο εικονίδιο της συσκευής. Όταν οι υποστηριζόμενες υπηρεσίες 
εμφανιστούν επιλεγμένες, πηγαίνετε στο εικονίδιο της υπηρεσίας Object Push 
Service (θα πρέπει να εμφανίζεται με κίτρινο χρώμα) και κάντε δεξί κλικ. Από το 
μενού που εμφανίζεται μπορείτε να επιλέξετε ένα από τα ακόλουθα στοιχεία: 
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• Send My Card: Στείλτε την προκαθορισμένη επαγγελματική σας κάρτα. 
• Get Card: Λάβετε την προκαθορισμένη επαγγελματική κάρτα της 

απομακρυσμένης συσκευής. 
• Send Objects: Επιλέξτε κάποια αντικείμενα (PIM files) για να στείλετε. 
• Exchange Cards: Ο υπολογιστής σας και η απομακρυσμένη συσκευή θα 

ανταλλάξουν τις προκαθορισμένες επαγγελματικές κάρτες τους. 
 

2. Από το MS Outlook: 
Επιλέξτε την επαφή που θέλετε να στείλετε. 
Στο Outlook, πατήστε το κουμπί Push που υπάρχει στην μπάρα εργαλείων (ή πηγαίνετε 
στο File → Push) 

 

Εμφανίζεται το παράθυρο Bluetooth Neighbor. Στη λίστα συσκευών, επιλέξτε την 
απομακρυσμένη συσκευή στην οποία θέλετε να στείλετε την επαφή και πατήστε Push. 

 
 
Λήψη Αντικειμένων από ένα Κινητό Τηλέφωνο με Bluetooth  
In the Main Window, go to My Services → Properties and select the Object Push tab, 
in order to configure the parameters for the object push. 
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Εκκινήστε την υπηρεσία Object Push. Μην εκκινήσετε τη σύνδεση. 
Στείλτε αντικείμενα από την απομακρυσμένη συσκευή (για περισσότερες πληροφορίες 
σχετικές με το θέμα αυτό, ανατρέξτε στο εγχειρίδιο της αντίστοιχης συσκευής) 
 
Σημείωση: 
Τα αντικείμενα που λαμβάνονται από άλλες συσκευές αποθηκεύονται στο φάκελο My 
Documents → Bluetooth → Inbox. Τα αντικείμενα που αποστέλλονται από τον 
υπολογιστή σας αποθηκεύονται στο φάκελο My Documents → Bluetooth → Outbox. 
 

6.4.9 Personal Area Networking 
Το Bluetooth Personal Area Networking (PAN) Profile σας επιτρέπει να συνδέετε μεταξύ 
τους Bluetooth συσκευές και να σχηματίσετε ένα δίκτυο PAN (προσωπικό δίκτυο). 
Υπάρχουν δύο είδη δικτύων PAN: 

1. Το Group ad-hoc Network (GN), είναι ένα απομονωμένο δίκτυο στο οποίο 
συνδέονται χρήστες (PAN users – PANUs) μέσω ενός GN controller. 
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2. Ένα PAN μπορεί να αποτελείται από χρήστες (PANUs) που συνδέονται σε ένα 

Network Access Point (NAP), το οποίο παρέχει πρόσβαση σε κάποιο εξωτερικό 
δίκτυο LAN (τοπικό δίκτυο).  

 
 

Το BlueSoleil υποστηρίζει τους εξής τρεις ρόλους: GN (controller), PANU και NAP. 
 
Σύνδεση του χρήστη PAN (PANU) 

1. Συνδεθείτε στην υπηρεσία Personal Area Network του server. 
2. Μετά από λίγο, το BlueSoleil θα βρει και θα εμφανίσει την ΙΡ διεύθυνση του 

υπολογιστεί σας. 
 
Ρυθμίζοντας το NAP/GN 
Πηγαίντε στο Bluetooth Service → Properties και επιλέξτε την καρτέλα Personal Area 
Network. 
 

1. Group Ad-hoc Network 
Επιλέξτε Set up Bluetooth Personal Area Network και Enable DHCP Server. 
Ένας DHCP server θα ξεκινήσει στον GN. Ο χρήστης PANU μπορεί να αποκτήσει ΙΡ 
διεύθυνση αυτόματα από αυτόν τον DHCP Server αν δεν έχει τεθεί στατική 
διεύθυνση για το BT Network Adapter. 
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2. Πρόσβαση σε LAN μέσω PAN-NAP 
Επιλέξτε Access LAN Network και στο πεδίο LAN Adapter επιλέξτε την κάρτα 
δικτύου (physical network adapter) μέσω της οποίας το NAP συνδέεται στο LAN. 
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Σημείωση: Σε περιβάλλον Windows Vista αυτή η λειτουργία δεν υποστηρίζεται. 
 

 

6.4.10 Printer 
Το Bluetooth Printer Profile (HCRP) σας επιτρέπει να συνδέσετε τον υπολογιστή σας με 
έναν Bluetooth εκτυπωτή και να εκτυπώσετε. 
 

1. Συνδεθείτε στην υπηρεσία Printer του εκτυπωτή. 
2. Πρέπει να έχετε εγκαταστήσει τους σωστούς οδηγούς για τον εκτυπωτή στον 

υπολογιστή σας, αλλιώς το BlueSoleil θα σας ζητήσει να τους εγκαταστήσετε. 

 
Εγκαταστήστε τους οδηγούς για τον εκτυπωτή και αναθέστε στη θύρα του εκτυπωτή 
το σωστό αριθμό θύρας COM. Για να προσδιορίσετε το σωστό αριθμό θύρας COM, 
πηγαίνετε στο Main Window, κάντε δεξί κλικ στο εικονίδιο της συσκευής που 
αντιστοιχεί στον εκτυπωτή και επιλέξτε Status από το μενού που εμφανίζεται. 
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Αν οι οδηγοί για τον εκτυπωτή έχουν εγκατασταθεί, εμφανίζεται ένα μήνυμα που 
δηλώνει ότι ο εκτυπωτής είναι έτοιμος: 

 

3. Εκτυπώστε έγγραφα χρησιμοποιώντας τον Bluetooth εκτυπωτή. Βεβαιωθείτε ότι 
έχετε επιλέξει το σωστό εκτυπωτή και τη σωστή θύρα. 

 

6.4.11 Serial Port 
Το Bluetooth Serial Port Profile (SPP) προσφέρει στις Bluetooth συσκευές μία εικονική 
σειριακή θύρα, έτσι ώστε να μπορούν να συνδέονται μεταξύ τους μέσω Bluetooth αντί 
μέσω καλωδίου. 
Το BlueSoleil υποστηρίζει τέσσερις σειριακές θύρες Bluetooth για εξερχόμενες 
συνδέσεις και δύο σειριακές θύρες Bluetooth για εισερχόμενες συνδέσεις 
. 
Σύνδεση σε μία συσκευή Bluetooth 
 

1. Συνδεθείτε στην υπηρεσία Serial Port της συσκευής. 
2. Χρησιμοποιήστε το ActiveSync ή άλλο λογισμικό που χρησιμοποιεί σειριακή 

σύνδεση. 
 
Σημείωση:  

• Serial Port Auto-Connection function 
Όταν μία συγκεκριμένη σειριακή θύρα ανατεθεί σε μια συσκευή, κάθε φορά που 
μία εφαρμογή ανοίγει τη θύρα αυτή, το BlueSoleil θα συνδέεται αυτόματα στη 
συσκευή αυτή. Κάθε φορά που μια εφαρμογή κλείνει τη σειριακή θύρα, το 
BlueSoleil θα σταματά τη σύνδεση. Για να δείτε ποιες σειριακές θύρες έχουν 
ανατεθεί σε ποιες συσκευές, πηγαίνετε στο Tools → Configurations → Quick 
Connect… 

• Μερικές εφαρμογές σας επιτρέπουν να χρησιμοποιήσετε σειριακές θύρες με 
συγκεκριμένους αριθμούς. Αν η εφαρμογή δε σας επιτρέπει να χρησιμοποιήσετε 
μια σειριακή θύρα που έχει ανατεθεί από το BlueSoleil, τότε δε θα μπορέσετε να 
χρησιμοποιήσετε το BlueSoleil με την εφαρμογή αυτή. 

 

6.4.12 Synchronization 
Το Bluetooth Synchronization (SYNC) Profile σας επιτρέπει να συγχρονίζεται τα 
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αντικείμενα ΡΙΜ που βρίσκονται στον υπολογιστή σας με αντικείμενα που βρίσκονται σε 
άλλες Bluetooth συσκευές. 
Τα αντικείμενα που υποστηρίζονται ε: 

1. Επαφές (Contacts) (*.vcf) 
2. Ημερολόγια (Calendars) (*.vcs) 
3. Σημειώσεις (Notes) (*.vnt) 
4. Μηνύματα (Messages) (*.vmg) 

Οι εκδόσεις του Outlook που υποστηρίζονται είναι: MS Outlook 2000, Outlook 2002 
(XP), Outlook 2003 
 
Συγχρονισμός με ένα κινητό τηλέφωνο με Bluetooth 

1. Συνδεθείτε στην υπηρεσία Synchronization του κινητού τηλεφώνου. 
2. Εμφανίζεται το ακόλουθο παράθυρο: 

 

Πατήστε το  για να αρχίσει ο συγχρονισμός των δεδομένων. 

Μπορείτε να αρχίσετε τη διαδικασία συγχρονισμού από το MS Outlook 
χρησιμοποιώντας τα Bluetooth Add-In μενού και κουμπιά που έχουν εγκατασταθεί 
από το BlueSoleil. 
 
BlueSoleil μπορεί να λειτουργήσει ως server συγχρονισμού. Πηγαίνετε στο My 
Services → Properties, επιλέξτε την καρτέλα Information Synchronization και 
επιλέξτε τον τύπο του ΡΙΜ αντικειμένου που θέλετε να συγχρονίσετε. 
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7 Τεχνική Υποστήριξη 
 
Για τεχνικές πληροφορίες και υποστήριξη επικοινωνήστε μαζί μας: 
 
Δικτυακός τόπος: www.crypto.gr 
E-mail: support@crypto.gr 
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8 Τεχνικές Προδιαγραφές 
 
USB v1.1 
 
Compliant with Bluetooth 2.0/1.2/1.1 Specification 
 
Operating range: 100 m  (class 1) 
 
Frequency Range: 2.4-2.48 GHz ,79 Channel FHSS 
(Frequency Hopping Spread Spectrum) 
 
Data Transfer rate: max 3Mbps 
 
Rx Sensitivity: 0.1% BER/PIN: -80 dBm 
 
AFH (Adaptive Frequency Hoping): Co-existence 
with Wi-Fi: no interference 
 
ESCO (Extended Synchronize Connection 
Oriented): improved voice quality 
 

 
A2DP (Advanced Audio Distribution Profile) 
 
AVRCP (Audio Video Remote Control  Profile) 
 
Input Voltage / Current: DC 3.3V / 100mA 
 
Current Consumption: 25mA (Standby mode) 
                                     80mA (Transmission mode) 
 
Antenna: Integrated antenna 
 
ISSC chipset with IVT software for Class 1 
 
OS compatibility: Win 2000/XP/Vista 
 

 

Technical Specifications are subject to change without prior notice. 

 

9 WEE Συμμόρφωση 

Απόρριψη χρησιμοποιημένων ηλεκτρικών και ηλεκτρονικών συσκευών  

Εάν πάνω στο προϊόν ή στη συσκευασία του προϊόντος υπάρχει το σύμβολο αυτό, τότε 
δε θα πρέπει να πετάξετε το προϊόν μαζί με τα κοινά οικιακά απορρίμματα, αλλά να το 
παραδώσετε στο κατάλληλο σημείο περισυλλογής για την ανακύκλωση ηλεκτρικού και 
ηλεκτρονικού εξοπλισμού.  
Η ανεξέλεγκτη απόρριψη τέτοιων προϊόντων ενδέχεται να έχει βλαβερές συνέπειες για το 
περιβάλλον και την υγεία των ανθρώπων.  
Για περισσότερες πληροφορίες σχετικά με την ανακύκλωση του προϊόντος αυτού, 
μπορείτε να επικοινωνήσετε με το δήμο σας, την υπηρεσία αποκομιδής οικιακών 
απορριμμάτων ή το κατάστημα από το οποίο αγοράσατε το προϊόν. 
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10  Ευρετήριο Όρων 
A2DP Advanced Audio Distribution Profile (αναφέρεται και ως AV profile), χρησιμοποιείται για τη

μετάδοση στερεοφωνικού ήχου όπως μουσική από ένα mp3 player σε ένα headset ή 
ηχοσύστημα αυτοκινήτου. 

Access Point 
(AP) 

(Σημείο Πρόσβασης). Ένα μηχάνημα ή λογισμικό που σκοπό έχει να συνδέσει ενσύρματα 
και ασύρματα δίκτυα μεταξύ τους 

Ad-hoc Ένα ανεξάρτητο ασύρματο δίκτυο που αποτελείται από μια ομάδα υπολογιστών
εξοπλισμένων με ασύρματες κάρτες δικτύου 

AVRCP Audio/Video Remote Control Profile, ένα προφίλ που παρέχει ένα πρότυπο interface για τον
έλεγχο τηλεοράσεων, ηχοσυστημάτων κλπ. Επιτρέπει σε ένα μόνο τηλεχειριστήριο να
ελέγχει όλο τον οπτικοακουστικό εξοπλισμό ενός χρήστη. 

BlueSoleil Το BlueSoleil είναι ένα πρόγραμμα που επιτρέπει την επικοινωνία συσκευών που
υποστηρίζουν την τεχνολογία Bluetooth. 

Bluetooth Πρόκειται για ένα πρότυπο ασύρματης διασύνδεσης υπολογιστικών και επικοινωνιακών
συσκευών με χρήση ραδιοκυματικών πομποδεκτών μικρής εμβέλειας, χαμηλής ισχύος και
χαμηλού κόστους. Είναι επίσης γνωστό ως IEEE 802.15.1. 

DHCP Το Dynamic Host Configuration Protocol είναι ένα πρωτόκολλο που αναθέτει αυτόματα 
δυναμικές διευθύνσεις IP στις διάφορες συσκευές ενός δικτύου. 

Dongle Πρόκειται για μια μικρή συσκευή η οποία συνδέεταιA dongle is a small hardware device that 
connects to a computer to authenticate some piece of software. It can also refer to something 
that plugs into a computer, especially something with wires that “hang” (dangle) from a 
laptop computer. 

HCRP Hardcopy Cable Replacement Profile 
HID Human Interface Device. Πρόκειται για ένα τύπο συσκευών για υπολογιστές που επιτρέπουν

στους χρήστες να εισάγουν δεδομένα ή να αλληλεπιδρούν άμεσα με τους υπολογιστές, όπως
ποντίκι, πληκτρολόγιο κλπ. 

LAN Local Area Network – Tοπικό δίκτυο, ένα δίκτυο υπολογιστών που καταλαμβάνει σχετικά
μικρή περιοχή. Τα περισσότερα LAN περιορίζονται σε ένα κτήριο ή συγκρότημα κτηρίων. 

NAT Network Address Translation – Μετάφραση Διευθύνσεων Δικτύων. Μηχανισμός για την 
ελαχιστοποίηση της ζήτησης για παγκόσμια μοναδικές διευθύνσεις IP. To ΝΑΤ επιτρέπει σε 
ένα οργανισμό με διευθύνσεις που δεν είναι μοναδικές παγκοσμίως να μπορεί να συνδεθεί 
με το Internet μέσω τις μετάφρασης αυτών των διευθύνσεων σε μία διεύθυνση που είναι 
μοναδική παγκοσμίως. 

PAN Personal Area Network (προσωπικό δίκτυο). Είναι ένα δίκτυο υπολογιστών που
χρησιμοποιείται για επικοινωνία μεταξύ συσκευών (συμπεριλαμβανομένων κινητών και
PDAs) οι οποίες βρίσκονται κοντά σε ένα άτομο. Οι συσκευές μπορεί να ανήκουν ή όχι στο 
συγκεκριμένο άτομο. Η εμβέλεια ενός τέτοιου δικτύου είναι συνήθως μερικά μέτρα. Τα
PANs χρησιμοποιούνται για επικοινωνία μεταξύ προσωπικών συσκευών ή για σύνδεση σε
άλλα δίκτυα και στο Ίντερνετ. 

PDA Personal Digital Assistant, μια φορητή, μικρή και ελαφριά συσκευή που έχει συχνά και
γραφίδα και χρησιμοποιείται ως τηλέφωνο και organizer. 

 
 


